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Being creative with a word processor 
 

First, learn your word processor 
 
In this guide red type is used for emphasis, blue type for names and menu items and other 
elements in the word processor interface. 
 
Note: if you are following this guide on a print out, then it’s a good idea to have your word 
processor running, as I will keep asking you to do things. But it’s even better if you have this 
document opened up in your software. If you need to turn on your computer, or open a particular 
program, do it now. When you have done it, read on… 
 
What is creativity? And what has it got to do with a computer? If creativity is a mixture of insight 
and hard work, then it seems sensible to use tools that make the work easier by doing the boring 
stuff for you.  
 
In writing this guide I am assuming that you have the use of word processing software – 
something like Microsoft Word™, Lotus WordPro™ or WordPerfect™. Although these are 
expensive and sophisticated products, many of the things you will use are also to be found in free 
software, like Microsoft WordPad, which comes as part of the Microsoft Windows™ standard 
installation. If you cannot afford to purchase a word processing application, then you can find 
many powerful programs free, either as downloads from the Web or on cover disks with 
magazines. 
 
The clever people who design these programs have been very thorough. They have consulted 
professional publishers and discovered all the things that they want to be able to do with 
documents. And then they have programmed the software to make it do these things quickly and 
easily. To give one example – if you want to know the number of words in this document or any 
part of it, you can use the word count tool. Try it now – it’s on the tools menu. It will count all the 
words in a document (default action) or just those in a passage you select. 
 
You will never use all the features in your software – life is too short for you to learn. But there are 
lots of features you should know, which you can use in making your own resources or in helping 
children work. 
 
An easy and obvious way to organize these things under categories or headings is to use the 
menu names that the software designers have settled on. These change over time, and are not 
exactly the same in all programs or all program versions. I have written this guide specifically to 
support work in Microsoft Word 2000™. But you can easily apply most of it to other software. 
 
Most software has redundancy programmed into the interface and design. This means that there 
are several different ways to achieve any given result. For every menu item there is somewhere a 
toolbar item, shown as an icon or button. The software designers choose which ones you start 
with (a default view), but you can add or remove them, according to your own preferences. 
However, in this guide I have found it more convenient to group them under the menu headings 
or categories. 
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The menu names or headings 
 
So what are these menu headings and what is in the menus? They are: 
 

• File 
• Edit 
• View 
• Insert 
• Format 
• Tools 
• Table 
• Window 
• Help 

 
In a way, the last is much the most important. If you know nothing about the software, you can 
use the on-screen help to teach you everything. Of course, this never quite works. You would 
love to have time to experiment but you need to do this job NOW. Later, when you do have time, 
the last thing you will want to do is play with some boring software. Which is why your children 
often know things you don’t – they are endlessly curious and will explore what every button or 
menu item does. But the software designer wants you to use the programs like a child. You can’t 
break it! I won’t tell you anything about help, because the programmers have already done it far 
better than I could do, even if I had years – and I don’t. 
 
But here’s an idea – when the program first loads, a tool tip will appear on the screen. (If this 
doesn’t happen, your first trip into Help can be to make this happen.) Make a point of reading the 
tool tip, and trying out whatever it tells you (apart from occasional joke messages about your 
dress sense). Alternatively, every time you save your work and leave the program, spend five 
minutes before quitting finding out what some menu item does which you have never used 
before.  
 
One more point before looking at the first menu. The latest versions of Microsoft Word™ are too 
clever for some of us. They will not show all the menu items, only those you have used. This is 
not really clever, as after a while you won’t even know there are other things on the menu. So the 
software will reinforce your ignorance. To make the whole menu appear you need to move your 
mouse pointer over the downward-pointing double chevron at the bottom of the menu. What’s a 
double chevron? Don’t expect a description or little graphic here: have a look now. 

The file menu 

New 
You use this to start a new file. So what? Well do you accept the first document offered to you 
“blank document” or do you ever try out the other choices? These allow you to create a document 
based on a template. Try out a few of them to see what they look like. if you find one you like, you 
can customize it for your children to use. To do this, you need to alter the settings for the normal 
paragraph style and different headings, then save the result as a document template – use save 
as, then save as type and choose Document Template (*.dot). Give the template a name (such 
as Class9blue.dot), and then click on the save button.   
 
You can get lots more templates from the Web, though most will be aimed at adult users. If you 
create your own, why not share them with others? 
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Print preview 
An obvious point, but you can save on printing costs by using Print Preview until you are certain 
the document appears as you want it to. 
 

The edit menu 

Copy, cut and paste 
This is one of the most creative of the sets of tools on the word processor. Use Copy to grab 
blocks of text, images, tables and other data objects and Paste to place them in your document. 
You can format the text later, to make it appear as you want. 

Find  
This is a very useful tool for reading and research tasks. Children can predict how often a given 
word or other text string occurs in a text. You can use this to find out which are the most common 
words or phrases. 

Search and replace 
This is even more powerful, if you use it to find a given bit of text. You can replace this text with 
the SAME text, but in a different format. So, for example, you can take a play or poem and 

replace the word king with king or blood with blood. (If the second doesn’t look interesting 
then you don’t have the fancy font – Chiller – which I have used here.) 
 
Another trick is to replace a letter with a symbol, or do this for several or all letters, to create 
ciphers (codes) or puzzles for children to break. Here is this paragraph with all of the vowels 
replaced. 
 
1ν4τη2ρ τρ3χκ 3σ τ4 ρ2πλ1χ2 1 λ2ττ2ρ ω3τη 1 σψµβ4λ, 4ρ δ4 τη3σ φ4ρ σ2ϖ2ρ1λ 4ρ 1λλ λ2ττ2ρσ, τ
4 χρ21τ2 χ3πη2ρσ (χ4δ2σ) 4ρ π5ζζλ2σ φ4ρ χη3λδρ2ν τ4 βρ21κ. Η2ρ2 3σ τη3σ π1ρ1γρ1πη ω3τη 1λλ 
4φ τη2 ϖ4ω2λσ ρ2πλ1χ2δ. 
 
To reveal the original form, just select any encrypted text, and change the font to Arial (or any 
standard letter font). See what happens. To replace the vowels, you will need to use the replace 
function, guessing which numbers match which letters. 
 
You can also play “guess the word”, by replacing every occurrence of a chosen word throughout 
a longer text. Children use clues from the surrounding context to guess the meaning. 
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The view menu 

Outline 
The View menu determines how the page looks on screen as you work. It does NOT affect the 
way the page will appear if you print it (use Print Preview for this). Most people have it set to 
Normal or Print Layout. But if you select Outline, you will find that you have lots of very useful 
tools for moving blocks of text. Try this now, and find the effect of clicking on the up or down 
arrows. 
 
You can use the Outline view tools to rearrange a block of text (say a poem) that you have put 
into a different order from the original. Try it with this text now! (You may wish to use the File 
menu to open a new document, and then Copy and Paste this text into it.) 
 

Birds turn their heads as she approaches, 
Stare from bushes at her blank-faced coaches. 
 
Snorting noisily, she passes 
Silent miles of wind-swept grasses. 
 
Pulling up Beattock, a steady climb: 
The gradient’s against her, but she’s on time. 
 
Past cotton-grass and moorland boulder, 
Shovelling white steam over her shoulder, 
 
In the farm she passes no one wakes, 
But a jug in a bedroom gently shakes. 
 
Sheep-dogs cannot turn her course; 
They slumber on with paws across. 
 
This is the Night Mail crossing the Border, 
Bringing the cheque and the postal order, 
 
Letters for the rich, letters for the poor, 
The shop at the corner, the girl next door. 

 
None of the stanzas has been changed inside. All that has changed is the order (sequence) of 
the stanzas. Ask children to create the best sequence of stanzas. Note that W.H. Auden’s original 
version is not the only possible “right” answer here. 

Toolbars 
 
Your word processor has lots of toolbars. Usually you will see some but not all of these. The View 
menu allows you to display others. One of the most useful is the drawing toolbar. 
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The drawing toolbar  
 
Use this to insert drawings, basic shapes, text boxes and callouts. What are these?  
 
 
 
 
 
 
 
 
You might know of them as speech bubbles – text boxes with a pointer that you can drag. You 
won’t see the callout unless you have the Print Layout view showing. Switch views to make it 
appear or hide it. Think of creative ways you can use these.  

Insert 
The Insert menu is good for putting images into your document, or things like page numbers and 
the date and time when the document was created. Practise putting these objects into your 
document: 
 

• Picture 
• Symbol 
• Object 
• Text box 
• Auto shape 
• Comment 

 

The format menu 
 
Once you have created a text or copied it from elsewhere, you can change its appearance to 
match the style you have chosen for your schoolwork.  If you have a consistent house style, then 
your documents will look better together, and children may learn where to look for things. Some 
of the most important features of format are.  
 

Font 
This refers to the typeface or style. Professional typographers suggest that no more than two 
different fonts should appear on any page. Research shows that serif fonts (such as Times New 
Roman, which looks like this) are easier to read on a page, while sans serif fonts (such as Arial, 
which is used for this document) are easier to read on a computer monitor. 
 
For emphasis you can use colour, bold or italic. For another level of emphasis, you can use 
underlining. However, underlining on titles looks ugly – you won’t see it on many professional 
publications. In writing Web pages, you should avoid underlining, as the browser uses this feature 
to show a hyperlink.  
 

This is a callout! 
Put some words in it! 
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Paragraph 
You can set the style for paragraphs of various kinds, which show the structure of the document. 
For example, you can have a different style for each descending level in a hierarchy. 
Alternatively, you can keep the paragraph style the same, while using different levels of header, 
as in this document. 
 

Borders and shading 
You can set a range of borders and shading effects around different blocks or selections of text. 
This is a good way to make a selection stand out. But this works best if you use it sparingly. 
 
 
You can set a range of borders and shading effects around different blocks or selections of text. 
This is a good way to make a selection stand out. But this works best if you use it sparingly. 
 
 

The tools menu 
 
This is the most powerful selection of specialist tools for working on your document. You need to 
explore them in your own time, but you may want to pay attention to these. 
 

Word count 
Use this to teach children to write to a specified word length. You can get it to count all the words 
in a document, or in a selection. 
 

Spelling and grammar 
Use this intelligently. Make sure you set it to use the version of English you want children to use – 
UK or International English rather than US English. You can, of course, change the country 
settings and see how this alters a document. 
 
Options  
 
When you begin to understand how the word processor works, this is a very powerful tool for 
showing you what children have done. You need to select the View tab, and in the section called 
formatting marks, check the box against “all”. This will show in screen (but not on a print out) the 
non-printing characters. You can see, for example, where a child uses the space bar rather than 
an alignment tool to centre a heading. 
 

The table menu 
 
We save the best for last. You never need to use desktop publishing software for creating 
complex page layouts. You can do this entirely by using tables. Remember that you can put a 
table inside another table, and that you need not show the table borders. 
 
Start a blank page now. Create some tables. If you want to make them expand vertically, then put 
some text in (it can be nonsense) or simply hit the Enter key several times. Use the Print Layout 
view, and alternate between seeing the whole page or seeing text at actual size. 



 

© Copyright: Andrew Moore, 2001 7 

Creative tasks 

First get some texts to play with 
 
If you have time and you are clever enough (of course you are) you can prepare some earlier. But 
you can use the computer (especially if you have a connection to the World Wide Web or a CD-
ROM drive) to find texts of all sorts – little and large, fiction and factual, serious and silly, classic 
or contemporary. 
 
Why not open your word processor now, and create a series of new documents. Use a template 
you like or have created for this work, or try out some of those that come with your word 
processor. Give each document a temporary name (e.g. yourname1.doc, yourname2.doc and so 
on). 
 
Now go online or open a CD-ROM or even explore what is already stored on your local hard drive 
or network drives. Find a text you want to work with – it’s up to you to decide what. If you don’t 
know where to find stuff online use a portal or search engine. 
 
Look for texts which are literary or non-literary; factual or fictional; for people in the UK or people 
elsewhere; for young and old; for specialist or general readers, and so on. 

Editing texts 

Change format and style 
Select the whole text or parts of it. Edit the text to make it look different. Do some of the following: 

• change font (size, style, colour) 
• change alignment (left, right, centre, justify) 
• use highlighting or add a comment 
• insert a picture 
• use text boxes or callouts 

Change form or genre 
This means, for example, turning a passage of play dialogue into a novel or short story. Use this 
as an example: 
 

Galileo’s rather wretched study in Padua. It is morning. A boy, Andrea, the housekeeper’s 
son brings in a glass of milk and a roll. 
GALILEO washing down to the waist, puffing and cheerful: Put that milk on the table, and 
don’t you shut any of those books. 
ANDREA: Mother says we must pay the milkman. Or he’ll start making a circle round our 
house, Mr. Galilei. 
GALILEO: Describing a circle, you mean, Andrea. 
ANDREA: Whichever you like. If we don’t pay the bill he’ll start describing a circle round us, 
Mr. Galilei.  

 
Rewrite this as the opening of a novel or story. You could also change the viewpoint so that 
Andrea is the narrator. Alternatively, take a passage from a novel and turn it into dialogue for a 
stage or television play.  

Continuing texts 
Use a passage of text as a starting point. Continue the text, keeping the style consistent. 
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Learning about language 
 

Substitutions 
 
Create banks of words of different classes. To help children you may use text colouring or 
highlighting. Write a model sentence, and then ask them to replace any words with other words of 
the same grammatical category. For example: 
 

The witty young teacher thoughtfully wrote a silly sentence. 
 

 
Adjective 

 

 
Adverb 

 
Noun 

 
Transitive verb  

(past tense) 
 

big 
little 
happy 
friendly 
sad 
unusual 
ridiculous 
blue 
intelligent etc. 

happily 
rapidly 
slowly 
carefully 
wisely 
regularly 
confidently 
patiently 
gently etc.  

octopus 
fish 
anteater 
teapot 
motorbike 
banana 
football 
boy/girl/man/woman 
roundabout etc. 

bit 
kissed 
touched 
ate 
cuddled 
fondled 
rode 
struck 
tortured etc. 
 

 
With luck you will get surreal but grammatically sound sentences, like: 
 

The toxic pink aardvark patiently fondled a drunken lifeboat. 
 

Pupils may illustrate these while labelling and colouring the word categories/parts of speech! 

Grammar checking 
If your word processor has a grammar checker you can use this as a teaching/learning tool. 
Children need to know that there are some things the grammar checker disapproves but which 
are acceptable standard forms. The trick is to give them some text that contains non-standard 
forms, and challenge them to correct it. To make it harder, you can ask them not to use the 
prompt tool, but to try to remove the green squiggle by their own best guesswork.  
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Language change and spelling 
 
Give children a text that uses archaic spelling forms. Ask them to modernize the spelling with or 
without the use of the dictionary and thesaurus tools in the word processor. You could also use 
this with regional or other varieties of English, such as pidgins. Here are some examples. Ask 
children to paste them into a new document, then alter the spelling into modern standard forms. 

Shakespeare: from A Midsummer Night’s Dream, Act 5, scene 1. 
 
The Lunaticke, the Louer, and the Poet, 
Are of imagination all compact. 
One sees more diuels then vaste hell can hold; 
That is the mad man. The Louer, all as franticke, 
Sees Helens beauty in a brow of Egipt. 
The Poets eye in a fine frenzy rolling, doth glance 
From heauen to earth, from earth to heauen. 
And as imagination bodies forth the forms of things 
Vnknowne; the Poets pen turnes them to shapes, 
And giues to aire nothing, a locall habitation, 
And a name. Such tricks hath strong imagination, 
That if it would but apprehend some ioy, 
It comprehends some bringer of that ioy. 

Robert Burns: A Red, Red Rose 
 
O my Luve's like a red, red rose, 
That's newly sprung in June: 
O my Luve's like the melodie, 
That's sweetly play'd in tune. 
 
As fair art thou, my bonie lass, 
So deep in luve am I; 
And I will luve thee still, my dear, 
Till a' the seas gang dry. 
 
Till a' the seas gang dry, my dear, 
And the rocks melt wi' the sun; 
And I will luve thee still, my dear, 
While the sands o' life shall run. 
 
And fare-thee-weel, my only Luve! 
And fare-thee-weel, a while! 
And I will come again, my Luve, 
Tho' 'twere ten thousand mile! 

A short passage in modern Scots 
 
Draw picters tae illustrate the poem. Mak up a wee play aboot ony o the verses in it, wi at least 
twa chairacters an some guid dialogue. Yaise yeir dictionary tae mak shair it's in guid Scots.  
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Change person and viewpoint 
 
Use the Find and Replace tools to change the viewpoint in a text. For example, turn a third 
person to a first person account. To do this, first replace a person’s name (every time it appears) 
with I. As soon as you do this, the grammar checker will alert you to places where I should be me, 
and to other changes you will need to make, for example to verb forms. Keep changing the 
passage until there are no mistakes in the grammar, and it makes sense when you read it aloud. 
 
You can reverse this process and change a first person to a third person account. 
 

Undo and redo as a teacher’s aid 
 
The Undo and Redo functions are very powerful – and not just to remove a change you don’t like. 
There are several ways to use the mouse or keyboard to control these tools – the most obvious is 
to click on the left and right pointing curly arrows on the toolbar (if you have this). Alternatively 
use the Edit menu, and choose the Undo or Redo options. Most convenient, if you can remember 
it, is to use the control key in combination with other letters on the keyboard – Control + z is Undo 
and Control + y is Redo.  
 
So what do you use them for? Take a text, and make a series of changes to it – for example, 
highlighting text or replacing words and phrases. (The changes can be of any kind that you might 
use in teaching.) It is critical that, having made the changes you do NOT save the changed 
version of the document. (If your word processor is set to save automatically – usually a good 
thing – then turn this feature off.) Now you can use Undo and/or Redo to make the changes 
appear in your document very rapidly – in effect you are able to present each stage of editing far 
more rapidly than would be possible by making the changes in real time. 
 
You can use this to make text suddenly become bigger or brighter, or even disappear (don’t 
delete it – just colour it to match the background). Like this. See if you can make the invisible text 
appear again – use the select tool, and/or choose a new colour! 
 

More ideas for creative use of the word processor 
 
Use ideas from the guide for original writing on Andrew Moore’s English teaching Web site. This 
is aimed at students in Years 10 and 11, but the tasks on the guide can be adapted for younger 
pupils. The page you want is: http://www.shunsley.eril.net/armoore/gcse/writing.htm  
 
Use Twenty Things to do with a Word Processor by Chris Warren and Trevor Millum. This 
contains ICT activities for pupils in Years 7 to 11, but many tasks are suitable for younger 
children, or can be adapted for younger pupils. The purchase price includes permission to 
photocopy the pupil activity pages. Purchase from NATE at 50, Broadfield Road, Sheffield, S8 
0XJ, or shop online at: http://www.nate.org.uk  

http://www.shunsley.eril.net/armoore/gcse/writing.htm
http://www.nate.org.uk/
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